MYTHBUNTU
RECORD FESTIVE TELEVISION WITH YOUR OWN MYTHTV BOX!

TOP 5 CHRISTMAS APPLICATIONS

GAMES, WHERE ARE THEY?
A READER'S OPINION

fullcircle magazine is not affiliated with or endorsed by Canonical Ltd.
Welcome to the December issue of Full Circle. 2008 is almost here and it's amazing to think that we've been doing this now for just over eight months. I remember saying in an IRC meeting for issue two or three that I'd be delighted if we make it to issue five. We did, and I am!

When I put that initial post up on Ubuntu Forums asking for help in making an Ubuntu magazine I never, ever, thought it would be anywhere near as popular as it is. Each month we serve up approximately 30,000 copies of FCM and that's not even counting the translations! I want to thank all of you who take the time to download and read FCM and contribute with letters and articles, it really couldn't come together without all the input we receive.

I also want to thank all the FCM team, in particular Robert Clipsham and Rob Kerfia who have been my henchmen since day one. Without their support and guidance this magazine would certainly never have happened! Thanks also go out to Canonical and the Ubuntu Marketing Team for their input, help and advice.

All of us at FCM would like to wish you a happy 2008!

All the best,
Ronnie
Editor, Full Circle Magazine
ronnie@fullcirklemagazine.org

What is Ubuntu?
Ubuntu is a complete operating system that is perfect for laptops, desktops and servers. Whether at home, school or at work Ubuntu contains all the applications you’ll ever need including word processing, email application and web browser.

Ubuntu is and always will be free of charge. You do not pay any licensing fees. You can download, use and share Ubuntu with your friends, family, school or business for absolutely nothing.

Once installed, your system is ready-to-use with a full set of productivity, internet, drawing and graphics applications, and games.

http://url.fullcirklemagazine.org/7e8944
eeeXubuntu: Ubuntu distilled for your Ee

For all you Ee users out there who've been trying to squeeze Ubuntu into the little white box, some help is on the way. A kind and enterprising Linux enthusiast has used their precious time and energy to put together an Eee-customized build of the much-loved OS, which includes fully-integrated hardware support, native wireless drivers, functioning Ethernet support, tweaks for low-resolution desktop environments, and a bunch of other little enhancements that will make using Canonical's powerhouse a lot more pleasant on your tiny laptop. Word on the street is that development and refinement continues on the build, so expect improvements as time wears on.

See next month's Full Circle for a review of the Asus Eee running eeeXubuntu with Compiz Fusion!

Source: Engadget
http://url.fullcirclemagazine.org/7b2320

MPAA's Piracy-Busting Toolkit Forced Offline

The Motion Picture Association of America (MPAA) has been forced to stop distributing its "University Toolkit" online after just one month because it may violate copyright laws.

The attempt to quash movie piracy via BitTorrent was taken offline on the 3rd Dec.

A suite of open source applications was cobbled together to make colleges spy on their students' file-sharing habits and encourage blocking. The package was based on Ubuntu, the desktop Linux distribution.

That would have been fine, except that the MPAA did not release the source code or provide a written offer for the code - potentially in violation of the GPL. All modifications to software licenced under the GPL, however minor, must be released.

Source: The Register
http://url.fullcirclemagazine.org/3f24dd

Firefox 3 beta 2 Officially Released

Mozilla has announced the official release of Firefox 3 beta 2, the tenth major developer milestone in the Firefox 3 development timeline. The new beta, which is available for download from Mozilla's web site, includes interface improvements and a lot of extra polish.

Mozilla's quality standards for betas require that all of the planned features be fully implemented and robust enough for daily browsing by a large number of people. That standard was fulfilled last month by the Milestone 9 release, which was the first to bear the beta designation. Additional betas will be released on a consistent basis until all of the implemented features are finalized and performance matches or exceeds that of Firefox. At that point, Mozilla will transition to release candidates to resolve last-minute regressions before the official release.

Source: Ars Technica
http://url.fullcirclemagazine.org/a81c71
Hardy Heron Tribe 1 released.

This is the first alpha version for the upcoming Ubuntu 8.04 (codename Hardy Heron) which will be coming out in April as a long term support (LTS) version taking over from Dapper Drake.

The Ubuntu developers are moving very quickly to bring you the absolute latest and greatest software the Open Source Community has to offer. The Hardy Heron Alpha 1 is the first alpha release of Ubuntu 8.04, and with this new alpha release comes a whole host of excellent new features. The feature list for 8.04 has been slowly taking shape since Heron opened late last month. While much is yet to be decided for 8.04, here are some of the new things that have already arrived, as well as a good look at the approved specifications.

You can find more information at https://wiki.ubuntu.com/HardyHeron/Alpha1

KDE 4 to ship in January.

This is good news for those Kubuntu users out there (Ed: can't wait!). Mark your calendars on Jan 11 2008 as the day that KDE 4 Stable is released. The team decided to move the release forward to allow some time to eradicate some issues in the software. KDE are also calling for the open source community and other users of KDE to help out with the bug testing that needs to be done.

Some parts of the desktop experience do not yet meet the KDE community’s quality standards and expectations for a stable release. There are also some issues which need to be addressed upstream, for example a bug in certain codecs of xine that cut off audio fragments prematurely. The developers are confident to be able to release a more polished and better working KDE 4.0 desktop in January. The changed plans involve releasing on January 11th, 2008.

You can find more information at: http://dot.kde.org/1196525703/

Macedonia to use Edubuntu

Macedonia has decided to install Edubuntu 7.04 Feisty Fawn onto the computers involved in the Computer for Every Child program. Their goal is to provide 180,000 Primary and Secondary students with access to about 20,000 Edubuntu computers.

“By selecting Ubuntu as the operating system for all of our classroom virtual PCs, our education system can provide computer-based education for all schoolchildren within the limited financial and infrastructural confines that most institutions face today.”

You can find out more at http://uri.fullcirclemagazine.org/c19870

And don't forget: on Friday the 14th December the pilot episode of the Full Circle Podcast was released. If you haven't already heard it, head over to www.fullcirclemagazine.org and download it.
Due to the length of the Mythbuntu install, I will skip the basic installation steps (language, location, keyboard type, user details and repartitioning), and go straight to step 6. If you would like a reference for the other installation steps please refer to a previous issue of Full Circle.

The first step just requires you to choose a standard or advanced setup. Standard would be too simple, so I went for advanced. The next step is to choose the type of Mythbuntu install you want. If you are planning to use the PC as a media center PC, then the first option is what you need, otherwise if you want to use it to stream media to your media center, just choose backend.

I chose "Primary Backend w/ Frontend", as this is likely to be the option you choose. The following step lets you choose the plugins you would like to use. If you are unsure which you need, or can't be bothered reading the descriptions, just select all of them, to give you all the available features. You can add extra plugins later if you decide not to install them all at that point.

I'm not sure why the next step exists. It has one check box to install one theme - select it and move on.

Step 10 gives some useful options, allowing you to choose which services you would like to enable. These include VNC, SSH, Samba, NFS and the MythTV service. VNC allows you to connect to Mythbuntu remotely using a graphical interface, so you can use the PC from another computer. SSH does the same thing, but gives command line access rather than Graphical access. Unless you have experience with a command line you should disable this one. Samba lets you file share with
Windows PCs on your network, NFS does the same, but for Linux/Other Unix clients. If you are using a separate back end and front end then you need to select the last option so they can connect.

Step 11 is an important step. You should set passwords for all the things listed, making sure they are all secured. Make sure you don't forget the passwords.

The next step allows you to configure your Mythbuntu remote control. If you don't have one, or yours isn't listed, skip this step. If it isn't listed there, don't worry - you may be able to install it later, once it Mythbuntu is installed.

Step 13 allows you to install proprietary drivers for your graphics card, to allow you to use OpenGL effects and TV output. It also gives you the option to install some back end drivers - install the ones you need.

Step 14 is the last step before the installation. It just gives you an overview of all your options so you can check them before you install.

The system now installs, then you will get the final step. If you are in North America, select the first option and set up an account if you don't already have one. After setting up an account, or if you aren't in North America, choose to launch the MythTV setup.

Once the MythTV setup has loaded, use the arrow keys to select your language. Then select each of the options in turn. In the General section, you need to set the machine's IP address. If it will be the only backend, then 127.0.0.1 is fine, otherwise set your router to give it a static IP address, and enter that in both boxes (unless you have a different master server). You can also choose different ports for Mythbuntu to use for more advanced options.

On the next step, choose where you would like to save recordings. The default is fine unless you want to save them somewhere else. The following step is for the global back end setup. Choose the correct TV format for your country (NTSC for US users, PAL for Europe). You also need to choose the…
correct channel frequency table for your region too.

The next step allows you to configure your DVB tuner if you have one. The following step is to allow you to make the back end automatically shutdown, hibernate or standby after a certain amount of inactivity. See http://url.fullcirclemagazine.org/9810cf for information on the different settings.

Next you have to set up MythTVs Wake on LAN settings. If you have only one back end this is unnecessary. After this, in the next few steps, you can define user defined scripts to run and other MythTV scripts to run at the same time as recordings. The built in ones allow MythTV to attempt to auto-detect commercial advertisements, and if you choose, remove them too.

Onto the second stage of the configuration. This stage allows you to set up a capture card. As I do not have a TV capture card I cannot give much advice for this, so use your intuition, and look at the guide I will mention later on.

After this you can configure your Video sources. Use XMLTV as your "Listings Grabber" unless you are in North America. Continuing onwards, you can link your video sources to inputs on your capture card; select the correct option from the list before downloading a channel list. Once the channel list is set up you are done with the configuration, and just have to click a few buttons to finalize the set-up, installing the database etc.

When you reboot you will be left with the Mythbuntu front end (if you installed it). From there you can test your set-up and make sure everything is working. If you used a different type of installation, e.g. just a back end install, then you will have to do some more configuration.

If you encounter any problems while installing Mythbuntu, or are unsure about any of the stages, there is a wealth of information available on the Internet to help you solve your problems. You can also find more complete installation guides, with more detailed instructions for installing, and instructions for different types of installation.

Links:
http://www.mythbuntu.org/
http://www.mythtv.org/
https://help.ubuntu.com/community/MythTV
#ubuntu-mythtv on chat.freenode.net
In this article I am going to try to walk you through using the Wubi installer to install Ubuntu onto your machine without any partitioning. Wubi will be installed as a single file on your Windows (98-Vista)-based computer. Please note that I am using an Alpha version (Wubi 7.10 Alpha Rev377) of the Wubi installer for Ubuntu 7.10

First, launch the Wubi installer application. The first option you'll see is your installation drive. Here you'll just want to choose the drive you wish to install your Ubuntu “file” onto. Make sure you have enough space on your drive. I recommend that you have 8GB or more of free space to really enjoy your Linux experience.

Install size is where you specify the size of your Ubuntu installation. The size you specify here is the total size of the file that will reside on the drive you want to install it on. Like I said, 8GB or larger is my recommendation for size.

The next option is to choose which flavor of Ubuntu you would like to install. Wubi can install any of the three basic Ubuntu versions:

- **Ubuntu** - Gnome based Desktop Environment
- **Kubuntu** - KDE based Desktop Environment
- **Xubuntu** - Xfce based Desktop Environment

When you choose the flavor of Ubuntu to install Wubi will automatically download the corresponding ISO. Once the ISO is done downloading Wubi will complete the installation, but I'll explain that later in the tutorial.

Language is pretty basic, choose the default language
you'd like in your Ubuntu installation.

This next area is where you will choose your desired username and password (below) for your Ubuntu installation. For security reasons “Root” is not an option when logging in for the first time on a default Ubuntu installation. You will have to fill this out to continue with your installation.

Once you have set your options and created your username and password, click on the “install” button.

Now since you've clicked on the install button and Wubi is beginning the installation of Ubuntu on your computer, you should see it begin to download the ISO version that you chose in the installer options. One thing can be said: There are two ways to get the ISO of Ubuntu 7.10 for a Wubi install. You can manually download it and if you choose to do this you will want download the ISO into the directory where you have your Wubi install program located. This needs to be done before you launch the Wubi installer so that it sees that there is an ISO there when you click the “install” button. If it's not there or you have chosen to install Ubuntu after downloading a Kubuntu ISO, for example, Wubi will automatically download the Ubuntu ISO.

Once the installation of Wubi is done you get this great news (right):

Choose what you want to do and click finish. On your next power up you'll see a lovely boot screen with the option in it to boot to Ubuntu. After you choose your new Ubuntu installation you'll see the Ubuntu boot screen and the progress bar. That bar may stop for quite a bit but let it go, walk away and get a cup of coffee. When you get back you should be up and seeing the Ubuntu Login screen.

Congratulations on your new adventure in computing and choosing Ubuntu to be that adventure. If you're like me or the rest of us Ubuntu fans you will not be disappointed.
I just saw my first Christmas lights a few days ago. Do you know what that means? I'm scrambling on my steep roof and putting up those “wonderful” icicles and decorating our ten foot high trees with lights up to the top. Not to mention those dang candles in the windows (which means putting out the lights on the upstairs windows and closing the shades). But Christmas time isn't all doom and gloom. It brings a very special time: decorating your GNU/Linux-based PC.

I'll start off with my collection of Christmas wallpapers (all related in some way to GNU/Linux). Here's a list of my favorite wallpapers:

**Ubuntu Christmas Wallpaper** created by kane77
http://url.fullcireclmagazine.org/6c61e5

**A Tux Christmas** created by g33z
http://url.fullcireclmagazine.org/582666

**Ubuntu Christmas** created by Marcelo Mendes
http://url.fullcireclmagazine.org/368106

**Happy Holidays With Tux** created by an anonymous author
http://url.fullcireclmagazine.org/cb8e9e

**Wrong Place at the Wrong Time** created by basse.
http://url.fullcireclmagazine.org/2b22f9

**Gnome Christmas (Remake)** created by vendettared.
http://url.fullcireclmagazine.org/8c87a2

**Ubuntu Christmas (Remake)** created by vendettared.
http://url.fullcireclmagazine.org/cf31fd

**KDE & Tux Christmas** created by LinuxHouse.tk.
http://url.fullcireclmagazine.org/14ac86

**Santa Tux**
http://url.fullcireclmagazine.org/0b6194

Download them, put them in a folder (like /usr/share/wallpapers), and make Gnome or KDE set to rotate between them every minute.

**Themes**

While you're customizing your look, you'll want to add a nice theme:

If you use Beryl, grab the **Christmas Beryl 3D Desktop Cube Theme** by tuxramone
http://url.fullcireclmagazine.org/5b22f6

GTK users will enjoy the **Christmas Theme in blue and green** by TheeMahn.
http://url.fullcireclmagazine.org/627269

If you use Gnome, you'll also want the **Ubuntu Christmas Login theme** by thecelloHude.
http://url.fullcireclmagazine.org/53855c
KDE users on the other hand should install the **Tux-Christmas splash screen** by TheOneAndOnlyFoo. [http://url.fullcirclemagazine.org/f5c86f](http://url.fullcirclemagazine.org/f5c86f)

And Firefox users will want to try out the **Tinseltown** by Thomas McMahon (aka TwisterMc). [http://url.fullcirclemagazine.org/94c83a](http://url.fullcirclemagazine.org/94c83a)

Lastly, if you're dual booting and using GRUB, create a splash screen using **QGRUBEditor** (by artemisfowl2007) and one of the wallpapers in the previous section. [http://url.fullcirclemagazine.org/3bd325](http://url.fullcirclemagazine.org/3bd325)

---

**Xsnow**  
(created by Rick Jansen, you can download it from: [http://www.euronet.nl/~rja/Xsnow/](http://www.euronet.nl/~rja/Xsnow/)) is a really old program for GNU/Linux that sends snow flakes, wind, and sometimes Santa's sleigh across your desktop. If you use KDE, you need to make sure programs can run in the desktop window (KControl>Desktop>Behavior and check 'Allow programs in desktop window').

![Xsnow](image)

**Xsnow (above)**

So go forth and whether you use GNOME or KDE you've no excuse, not only should you decorate your house but decorate your desktop too!

---
Making your computer boot a number of operating systems can be a very simple or complex issue. If you just want to set up a dual boot with Ubuntu and Windows there are lots of guides to help you do that, and often you don't even need to change any settings. This guide is not about that, although there is no reason one of the partitions could not be Windows. Another thing you should know before using this guide, is that you can set up a virtual machine, where an operating system can run in a window on your computer, and that is both a lot easier and safer.

O

K, so if you still want to set up a dual or multi boot system, there is one more thing you should know. This guide will not give step by step instructions, but will rather explain what you need to do in general. For example, instead of saying something like "Select the grey box representing free space in the top of the window, and press new..." this tutorial will just say "You need to create a new partition and format it ext3." If you think you need a more step by step tutorial, I recommend you ask for help on a forum, like UbuntuForums.org. And one last thing, this tutorial will assume you are using an empty hard drive. I don't recommend you do this for the first time on a hard drive you can't just reformat and start over. I messed up more then once, and I still don't even know what went wrong. Luckily, it was a blank hard drive, so I just started over.

Before you install anything, it is easiest to set up the partitions (pieces of your hard drive) in advance. Download and burn a Live CD that allows you to

FORMATTING THE DRIVE

**File system:** swap. **Type:** primary. **Size:** Approx. twice your RAM or 1.5GB to 2GB on a modern computer. **Use:** Sort of like extra RAM. Generally a good idea on Linux systems. **Notes:** None.

**File system:** ext3. **Type:** primary. **Size:** Depends on what distro you want to install. For testing purposes I recommend 10-12GB for CD distributions and 15GB+ for DVD distributions. **Use:** One of the distributions goes here. **Notes:** None.

**File system:** ext3. **Type:** primary. **Size:** Depends on what distro you want to install. For testing purposes I recommend 10-12GB for CD distributions and 15GB+ for DVD distributions. **Use:** One of the distributions goes here. **Notes:** If you only ever need three distributions, make another of this type and then you are done.

**File system:** N/A. **Type:** extended. **Size:** All available space. **Use:** Other partitions can go inside of this, but you can only have 4 primary/extended partition. Don't ask me why. Go try and Google it or something if you must know. **Notes:** All following partitions go inside this partition.

**File system:** ext3. **Type:** logical. **Size:** Depends on what distro you want to install. For testing purposes I recommend 10-12GB for CD distributions and 15GB+ for DVD distributions. **Use:** One of the distributions goes here. **Notes:** Goes inside the extended partition. Make as many of these as you need.
partition your drive. I recommend the GParted Live CD. This CD does partitioning, and just about nothing else, that's what makes it great. When you have booted it up these are the partitions you need to make (see 'Formatting the Drive' box on previous page)

You may want to make a logical fat32 (or ext3 if you only plan to have Linux on the computer you are working on) for data storage between operating systems.

Now, after you write the partitions to the disk (YOU WILL LOSE ALL YOUR DATA), you should see names such as /dev/sda1. (These names will vary from system to system depending on your hard drive.) Write these names down along with what partition they correspond to. At the very minimum you need to know the name of the partitions you want to put Linux on.

Also, if you mess up and want to restart, just put the CD back in the drive and delete all the partitions and make them again.

I hope that was clear, if not please email me at webmaster@linuxloop.com.)

**Installing the main OS**

To start out you need to install one "main" operating system. This is the only operating system you will allow to write the "Master Boot Record" (MBR). The MBR is a portion of your hard drive where your computer looks for a "boot loader" to tell it where to go to boot an operating system. In this tutorial we will use GRUB. GRUB is a boot loader that comes with most Linux distributions by default.

I normally use Ubuntu, but any Linux that can install a GRUB boot loader (almost all of them) will work. The only thing you need to do differently is that you need to choose "Manual" (or "Custom" or something) when you get to the partitioning options. Then you need to choose to install to the first of the ext3 partitions and choose mount point "/". You can let it format it if you want. Choose ext3 or ,if that is not an option ext2 (or whatever the distro prefers, it will not matter a lot).

**Installing another OS**

This is going to be the same as installing the main OS, except for two things. The first is that you don't want to use the same partition, so just pick the next of the ext3 partitions each time, but still use the manual mode

![Command Prompt Window](image.png)

Use the ↑ and ↓ keys to select which entry is highlighted. Press enter to boot the selected OS, 'o' to edit the commands before booting, or 'e' for a command-line.
and stuff. The second difference is that you don’t want it to write
GRUB to the MBR. This varies from
distribution to distribution and on
a few distributions, you can’t do it
at all. Basically, make sure that at
some point in the install process
you will get a chance to do one of
the following:

• **Best Choice:** Install GRUB to
the same partition that you
installed the OS to. This will be
phrased different ways, but if you
have an option to write GRUB to
the same partition you put the OS
on, that is the best choice.

• **Last Resort Choice:** Don’t
install any boot loader anywhere.

The only better thing then
installing GRUB to the same
partition, is installing it to the
same partition AND adding the OS
to the existing GRUB
automatically.

OK, so you got something
installed, now what to do next:

**If you were able to install
GRUB to the same partition as
the OS:** Go back into your main
OS, and open a terminal window. As
root (or in Ubuntu just add sudo to
the beginning) type gedit
/boot/grub/menu.lst. If you use KDE
you will need to use kedit or another
text editor instead. Now, go to the
bottom of the file and add (on a new
line):

```
title the name of the new OS
root (hd0,partition number)
chainloader +1
```

The name of the OS can be
anything, but I recommend just
using, for example, "Ubuntu 7.04."

To get the correct partition number
find the names of the partitions, that
you wrote down. Take the number at
the end of the name and
subtract one. That should be
it. For example, if the name
of the partition was
/dev/sda5, I would write

```
root (hd0,4)
```

**If you did not install a
boot loader at all:** Go back
into your main OS, and open
a terminal window. As root
(or in Ubuntu just add sudo
to the beginning) type gedit
/boot/grub/menu.lst. If you use KDE
you will need to use kedit or another
text editor instead. At
the end of this file you need to
add some lines of text. In this
case your best bet is to get
someone who has the distro
(both version and distro matter)
installed normally to tell you
what his/her entry(s) say.

I hope this works for you. If
you need addition help, please
contact me at:
webmaster@linuxloop.com or
look in www.UbuntuForums.org

![Gparted](image)

below: *Gparted*
In this, the last part of the Learning Scribus series, we will discuss exporting to the Adobe PDF format. While PDF is not exactly an 'open' file format it is easily the most widely used file format and means that your file will be viewable on Linux, Mac and Windows. Many professional print houses also accept PDF files for printing.

As ever, let's see what we have in Scribus first:

To export to PDF we go to main menu and choose File > Save as PDF

Which gives us the Pre-Flight Verifier:

This window may seem like a pest at times, always interrupting your PDF exports, but it is absolutely crucial that your document is created and exported properly to get a valid, and usable, PDF.

The drop down menu at the top right of the Pre-Flight Verifier window is to let you choose which version (or Profile) of PDF you want to export to. 'PDF 1.4' is about the best option to choose here. If you choose 'PDF 1.3' or any of the other options you run the risk of losing any fancy transparency effects you may have done.

Below the drop down menu is a list of your document pages and any conflicts that Scribus finds between your document and the PDF Profile you've chosen in the drop down menu. Here I've chosen the profile for 'PDF 1.3' and you can see it has given me a long list of errors, this is due to the semi-transparent numbers I put on the blank pages in a previous tutorial.

When I change the profile back to 'PDF 1.4' I only have one error and that is a text overflow on page one. That is
acceptable as the text is indeed too long for the text boxes on page one but it is only filler text and not important. You will also get warnings if any text or shape objects are not on a page properly.

So that's my one error and it's totally acceptable so I click the 'Ignore Errors' button.

**TIP:** You can call up the Pre-Flight Verifier window any time by clicking its button below the main menu.

Now we have the actual export settings:

At the top of the window is 'Output to File'. This is where you will save the PDF and what you want to name it. If you wish you can export each page as a separate file by simply checking the box below the file location box.

This window has six tabs (a seventh will be available if you choose the 'PDF/X-3' Profile) we'll work through these from left to right starting with the General tab.

---

**Export Range**

- All Pages
- Choose Pages

**Rotation:**

- 90°
- 180°
- 270°
- 0°

- Clip to Page Margins

Export Range lets you either export the entire document (All Pages) or export selected pages (Choose Pages), with the button checked for

Choose Pages you can enter something like: 1-3,5. That would export pages one through to three and also page five. Rotation, as it sounds, lets you rotate the pages in the exported PDF.

---

**File Options**

- Compatibility: PDF 1.4
- Binding: Left Margin
- Generate Thumbnails
- Save Linked Text Frames as PDF Articles
- Include Bookmarks
- Include Layers
- Resolution for EPS Graphics: 300 dpi

**File Options** lets you choose a new PDF Profile (Compatibility) and a margin for binding. You can then check boxes for generating thumbnails, including bookmarks and so on. Last option here is the resolution for EPS (vector) graphics, 300 dpi is for professional quality printing, if you are creating a document for viewing on screen or want to keep your file size down you could set this to 100dpi.

Compress Text and Vector Graphics will dramatically change your file size. Compression Method is set, by default, at Automatic and Quality is set to Maximum. Again, these are for professional quality printing. I can't say I'd recommend 'Lossy JPG' for the best Method but if you have to change it from Automatic I'd say choose 'Lossless ZIP'. For Quality I'd recommend you keep it at Maximum as otherwise it will start to heavily compress your images and your PDF will look quite dirty and grainy.

Fonts is the tab where we can see which fonts we've used and most importantly which fonts will be embed into the PDF.

---

17
If a font you've used in your document is not available on the reader's computer then you'd hit problems, thankfully this is overcome by embedding the fonts into the PDF file so it is important to click the Embed All button to save getting errors.

In this instance, Scrivus has embedded the 'DejaVu Sans Book' font. Be careful here as you can not embed all fonts, some bought fonts come with licenses that do not allow embedding.

The Extras tab gives access to presentation effects:

This is to effectively create a PDF slideshow. Something I doubt would be welcome at your local print shop!

The Viewer tab is very important for the display of your document.

Some PDF files will come as 'Single Page' where you scroll down viewing one page at a time. But some documents come displayed as an open book (Double Page) with two pages on screen at once. Document Layout is where this setting is selected. Double Page has a Left and Right option, this is where your front page will be. Right is what most European publications would use.

Visual Appearance is where you can use the PDF viewer applications' default settings or force other options such as full screen, display thumbnails and so on. Special Actions is rarely used but may come in handy if you want to execute some Javascript on opening a PDF.

Security is where you can encrypt your PDF with a password. You can also allow or prevent such things as printing, copying text and such like.

Colour tab has some settings for either 'Screen/Web', 'Printer' or 'Greyscale'. Most of the time you will use Screen/Web.

After you have sifted through the options you click Save and hope for the best! If it's your first time exporting a document to PDF then it will take a few tries to get it just the way you want it.

In closing, there are some things you must remember while exporting your document:

- Do not rely on user changeable options - such as menu bars - for presentation as the user can easily turn these back on again possibly making your document look ugly.
- It is best not to let your document
go full screen as some viewer applications may not ask or give a warning which may frighten viewers when their screens go black and flicker!

- The Pre-Flight Verifier is your friend, heed its warnings! You can click on an error in the Verifier window and it will jump to that page and highlight what, or where, the error is located.
- Think about your readers, if they are viewing your document on a slow computer or an old laptop then you really do not want to use the 'open book' format as their machine may be too old to quickly display two pages at once.
- To edit what is checked or unchecked in this document's Export PDF window you can go to the File → Document Set-up menu.

And that brings us to the end of my Learning Scribus series, I hope you've enjoyed it, I've seen some great things created by people who've followed this series so please, keep the emails coming!

Ref:
http://url.fullcirclemagazine.org/494f53
Scribus video tutorials.

Interested in: coding, hacking and security, non-Windows operating systems or gaming? Still in need of plans for your 2008 summer holiday? Read on, because ETHO might be just the thing for you!

ETHO is a nine-day LAN event taking place in the Netherlands in the summer of 2008. The first difference with most regular LAN parties is that ETHO takes place outdoors. You bring, not only your computer, but your own tent (or caravan) to an open field in the northern tip of Holland approximately 30 miles north of Amsterdam.

Many LAN parties are aimed solely at gamers – and often Windows only games at that - at ETHO, we are hosting a LAN event that caters to a wider audience than just gamers, by having informative speeches and discussion panels on a variety of subjects.

The LAN area will be divided into four villages:

- **The Open Village**: everything on Open Source, Open standards, security, Unix, Ubuntu and other non-Windows operating systems.

- **The Multimedia Village**: hosted by www.simuze.nl, a community for sharing music under the Creative Commons license, this village caters to performers and enthusiasts of music, video and other multimedia related things.

- **The Wireless Village**: as the name suggests, this village is about everything related to wireless technology.

- **The Gaming Village**: of course, just because the focus of the event is not on gaming, it doesn't mean we want to exclude gamers completely. Therefore, one village will be dedicated to games and gaming tournaments.

Each village has its own stage, where discussions will be hosted. This ensures a target audience truly interested in the presentation, and for the visitors it's easy to walk to a different village to learn about new subjects without having to go to a separate event.

As well as major speakers, every member of the public is invited to share their knowledge. If you have experience in a particular subject, you are invited to join our discussions or present a speech of your own. If you just want to listen and learn, and have fun with like-minded people, you're more than welcome to join us at ETHO as a visitor.

For more information, including various speeches we plan to have and how to sign-up, or if you can help us in any way, check our web site at www.eth-0.nl.
A relatively new application has found its way into the recent versions of many Linux distributions. It is called Tomboy. It contains several parts: a post-it application, a note pad, a cross-indexing tool and a quick publisher. It is also very addictive, easy to use and does away with the hassle of naming files and remembering directory paths. Tomboy is an evolving application and the latest release is still version 0.6. Even at this early stage, however, it is very robust. There are even many official and unofficial plugins available to enhance the application even further.

can access your notes quickly from the applet icon until you log out or quit the applet. You can also launch Tomboy every time you log in by adding this application in auto-start menu accessed from System > Preferences > Sessions > Start-up Programs. Click the new button to add “Tomboy” in name box and “tomboy” in command box. Next time you log in Tomboy will start automatically.

Over time you may tend to forget the file name in which you have saved your work or the directory where your file was located. For this purpose, desktop search tools are useful but comparatively cumbersome. With Tomboy, you do not have to remember and open any particular file under your directory tree. All your notes are stored under the name of the heading. Even better, they are
indexed. Tomboy creates its own hidden directory under your home directory. To see the contents of this directory you can "enable" view hidden files option in Nautilus and browse the contents, although there is no real need to do this.

Working on any Tomboy note can be accomplished with just two clicks. First click on applet icon (in the toolbar). This gives you a list of all notes that you have made in order of recent use. For the second click, select the note from the list to start working. You can launch multiple notes at the same time and you can open close or open notes as needed. The list of notes that are displayed is limited. If you want a note to always appear in the list you can make it sticky by clicking on the “pin” icon against the note so that even if it is not of recent use it will not disappear from view. The list also allows you to create a new note or to search for a text pattern in existing notes. Saving notes is as easy as just closing the note. There’s no need of giving a file name or a directory to store it in as Tomboy does that on its own.

When you start a new note Tomboy gives it a sequential heading automatically. To change the heading all you have to do is overwrite the default heading with your own. In effect the heading of the note is also the file name. Because of this, Tomboy does not allow you to have two notes of the same name and warns you when closing a note with same heading to change this. The interface is very simple as there are only five simple menus and a place to write your note. The menu items in the notes window are Search, Link, Text, Tools and Delete. As the name implies, the Search menu opens the search dialog box where you can define search criteria. It returns a list of all notes that contain your item with number of occurrence in each note. You can directly click on search results to open any note.

While writing a note, if you select a word (or several words) the link menu becomes active. If you click on this a new note with the highlighted word(s) as note heading is started. The highlighted word can also be given special formatting from the options available under the Text menu. Although limited, the text formatting options are sufficient. Standard short cuts of copy, cut, paste, bold, and italic also work. The Delete menu option deletes the current note. To prevent accidental deletions a confirmation box appears. The Tools menu gives rise to many more possibilities and we will discuss this a little later.
To make life easier Tomboy has some cool features like spell check, auto-linking and hyper-linking. Additionally, there are many plugins available that can enhance functionality. The spell checker will highlight any word that you spell wrong by underlining in red. By bringing the mouse cursor on top of the misspelled word and right clicking you get a menu for looking at alternative words. You can also add custom words to the dictionary so that they do not show up as spelling errors.

Auto-linking is one of the best features of Tomboy. This application indexes all words that are written in a note and compares them with headings of all notes that you have made. If it finds any word (or combination of words) matching heading of an existing note then this word(s) is automatically highlighted in red and a link is created to that note. On clicking the linked note is opened. This makes a great way of making cross referenced notes. Not only this, if you change the heading of a note which is linked from some other note the words in that note will also change to show the new heading! Watch out as this can have unintended consequences too. This is also the reason that you should keep headings unique and not use single words.

Tomboy also works with hyper-links, internal as well as external. For instance, if you write the full path to a local file like:

```
file://home/sudev/test.odt
```

A hyper link is automatically created within your note. When you click on this your system will fire up the associated application and open the target file. In this example the OpenOffice.org Writer program will be launched with test.odt file. This is a great way of embedding your files into notes and so that you don't have to remember the entire directory tree. You can have multiple file (links) in one note and multiple notes may link to one file.

Similarly, when an external hyper-link to a web page is clicked, it fires up your browser and the URL is opened within that. The moment you write a website URL or an email address it automatically creates a hyper-link. Clicking on an email address starts a compose (write to) window in your mail program.

The "Note of the Day" plug-in is not turned on by default. Once this feature is turned on then every day a new note is generated giving date as the heading with two sections for tasks and appointments. If you do not add any content then this
note is automatically deleted. This is similar to maintaining your daily diary.

Installing a plug-in is easy. A rather interesting and important plug-in is the “Remind” plug in and following the description below you can also start using this. First, download the binary from [http://raphael.slinckx.net/files/tomboy-reminder.dll](http://raphael.slinckx.net/files/tomboy-reminder.dll). Now open the plug-in folder by right clicking on applet icon, it is the first menu choice. Drag and drop the downloaded file in to this folder. Quit and restart Tomboy and then use the Preferences menu to enable the Remind plug-in. Now if in any note you write "Remind 15 August" the words will automatically highlighted in yellow indicating that a reminder has been set. On the 15th August this note will automatically pop up when Tomboy is running. If you are busy and close the note it will keep popping open every half an hour until you delete the reminder. Such convenience! You can write reminders in many formats. “Remind Sunday” “Remind 23 August at 11:30am” are all valid formats. Look up Tomboy home page or check out on the internet on additional information and other plug-in that are available.

There is no limit to length of note and you can write pages worth of text in one note. However, practically it is easier to break up notes in to many smaller notes. Or you can write long details in a file and give a file a link in a note that summarizes the details.

Now we come to the Tools menu. One basic choice is printing notes which opens the print dialogue with the usual printing options. Another option is to see what notes link to the current note. You can navigate to any of these notes by just clicking on the name. The most interesting option under this menu is Export to HTML. With this you can create a web page from your note with just click of a button. The pop up box also offers you the choice of exporting only the current note or all notes that are linked with the current note. Not only are linked notes are published in the web page, but intra-links are also created so that you can click and navigate from the .html page.

How can this be a killer feature that can enhance the functionality of Tomboy? Simple, just copy paste the output .html page to your web directory and you have a published document! In our organization we have configured web-server to allow personal pages. We cut and paste the .html output to our personal web-folder and send out emails with the link to people we want to share with. This way we can share information and in the same way by re-publishing from updated Tomboy note.

More information on Tomboy can be seen at the homepage: [http://www.gnome.org/projects/tomboy/](http://www.gnome.org/projects/tomboy/)
Honesty that is my question, where are they? Sure, there are a lot of freeware games out there that are fun and really put together well. But where are the big name titles? Where are Crysis, Hellgate London, World of Warcraft, Age of Empires, Guild Wars or any of the other blockbuster titles that are out for the Windows bunch?

What is it that keeps the EAs of the world (and by EAs I speak of publishers like Electronic Arts, UbiSoft etc.) from recognizing our lovely stable operating system? That is a question that I know has been thrown around for ages now. But it's still something that I constantly ask myself whenever I fire up my Windows box to play World of Warcraft or Battlefield 2142. Why can't we see this support for Ubuntu Linux and Linux in general?

I have been a fan of Linux since I played with Red Hat way back in the day. I have followed a lot of distributions such as Suse, Onebase (now defunct), Gentoo, Red Hat, and a few of the smaller distributions. My current love is Ubuntu which I've used off and on since 4.10. I have always kept up with what was going on in the realm of Ubuntu. But my real love on the PC is the gaming area, from First Person Shooters to Flight Simulators to RPGs. If they've been released I've tried to play them. From the good to the bad to the ugly, they've crossed my desktop. I just love games...

And this is where in my eyes (which remember are my eyes not your eyes) Linux is lacking just way too much. I know for one we can count on say id Software, developer of the Doom and Quake franchises, to release an update after their product is released to give us a working copy of a Windows based game for Linux. And i'm sure the developers of the Unreal franchise is another one of those companies that will support Linux. Unfortunately, like id Software, it is with a boxed item but with a patch. I don't want to get a patch to make a Windows based game run on Linux. I want a box with a CD or a DVD with the game on it, ready for installation on my Linux system. “But wait, we can use Wine or Cedega to run our favorite modern Windows games!” I know and I have used to run a few of my games, but that's adding an extra level of “complexity” that really shouldn't even exist for the average desktop user. People that are coming over from the Windows world are so used to sliding in the CD or DVD into their drive, installing the game, and having an icon on their desktop without having to know anything technical about their computer or operating system. When they make the transition
to Ubuntu they expect the same thing. We need native Linux games from big name companies with big name titles and we need them boxed and ready for purchase off our local game store shelves or from an online store.

Do you guys remember Loki Games? They were in my opinion one of our hopes for boxed games from the big guys out there. Loki released good products through their lifespan and I always thought they would garner enough interest in the Linux community that they'd stick around longer than they did. They would take a Windows based game and port it to Linux, with a custom installer for easy installation on any Linux computer capable of running the game. I think the last boxed Linux native game I bought was iD Software's own Quake 3 which was “ported” over to Linux by Loki and a fine one at that, and in all honesty I bought that, not for the deathmatch based gameplay but for the fact that it was going to support a company trying to bolster Linux's appeal as a gaming platform. Unfortunately in 2002 Loki decided to close up shop and with that we lost our one ability to get a boxed native Linux game.

My other interest is why is it that the main games that do get “ported” to the Linux platform are shooters? Why is that? Why do we not see Blizzard give the community a Linux client for their 10 million user massively popular MMORPG World of Warcraft; but we do get Unreal Tournament 3 released for the Linux platform? And while we are speaking of Blizzard why is it that they will release a client for the Mac operating system and on the Intel platform when we all know OS X has a foundation of BSD? Granted, Blizzard has always released both Mac and Windows versions of their games, but why not for Linux? Why is it that Oleg Maddox of Maddox 1c, developer of the IL2 franchise, will not do a “port” of IL2 to the Linux platform even when he has been asked numerous times about it? Yet on the other side of the coin iD software has released a free client for it's new Quake franchise entry and Battlefield series competitor Enemy Territory: Quake Wars. Why is it that the FPS genre will support the Linux community and platform to an extent but getting a company like Blizzard (World of Warcraft), Gas Powered Games (Supreme Commander), Relic (Company of Heroes) to even think about it is a chore unto itself?

I think the main detractor to the EAs of the world supporting the Linux systems out there is the market share. The Linux desktop market share just isn't there. With Apple having 8% market share now I can see the Mac garnering more interest in the game realm, even though Steve Jobs has an off again on again interest in gaming for his
systems (remember the unveiling of Doom 3?). Fact is, Mr Jobs just doesn't care about gaming on his systems. But if you look at Apple's market share, and it's current “hot” status with the consumer, I could definitely see their share of the desktop market increasing even more and fact be known Microsoft's share will not drop anytime soon. And with that, in my opinion the problem with this is that I don't see the Linux desktop increasing to the point that it can catch up to Apple. Without the average Windows or Mac user knowing about Ubuntu or Linux I don't feel it can catch up, and in essence won't gain the interest of the big EAs of the gaming world. And that means advertise on TV and in magazines, not just on the web. Word of mouth is good, but to get our penguin on more machines and gain its market share I feel that there should be Ubuntu advertisements in most computer magazines, television commercials (Let's see a Ubuntu vs. Windows vs. Mac ad. Now that would be interesting), etc. But that's just my opinion of course.

Another of the detractors is the overall support by the gaming companies for Microsoft's DirectX API. A majority of the games these days, no matter what genre, are designed with DirectX in mind. Yet if you look at the base engine of both the Quake series and the Unreal series they are built around the OpenGL API, which is an open graphics API and is totally supported by the Linux platform. Ubuntu (and Linux in general) does not have an DirectX compatible API set, so gaming companies would need to redesign their games in OpenGL or Microsoft would have to have DirectX support Linux to have a full featured 3D game engine. And again this is where Cedega comes in and allows Linux users to run DirectX enabled games, but it is not a foolproof way of playing those games. There's a lot of technical issues with playing these games through Cedega such as video issues, crashes, graphics card incompatibilities. The general desktop user will not want to haggle with those issues; it's a just work mentality. Which you can't blame since they are coming from a Windows world where the software is designed for it and pretty much works out of the box.

In closing, if we are to get Ubuntu (or Linux in general) seriously into the gaming market and thought of as a serious platform for gaming we need market share. To get that market share we need advertising and with advertising we will see interest from the desktop users that want change and as they come over and boost market share the EAs of the world will see our platform as a well rounded and stable gaming environment. Is what I'm saying so wrong? Absolutely not!
I am not the kind of person who feels a sense of pride in Microsoft bashing. I respect Microsoft as they put in a lot of effort in order to make a stable operating system which they update regularly with service packs and fixes. For this reason I used windows for about three or four years. But then I heard from a friend, that there is an OS named Ubuntu that is shipped free of cost with no postal charges. So, I decided to give it a try. When I started using Ubuntu, I learned over time that Ubuntu is a far better operating system.

On the opposite side of a nearby stream live a bunch of unruly grasshoppers. These grasshoppers did not live as a community but instead did as they wanted, often acting in their own self interest. Sometimes an aspiring grasshopper would come up with what he believed was a unique tool or structure. Motivated by greed, he would file a patent for his "invention" with the local patent office. Now, the patent office was run by moles who lived in ancient tunnels by ancient rules and understood little of bugs, tools or building codes. When these odd grasshoppers would file their applications, the moles simply approved them because it was easier than trying to understand. Believing the patent gave the grasshopper exclusive rights, each would fiercely defend his idea by either destroying anything that looked similar or requiring protection money. As a result, some grasshoppers were quite prosperous but most lived in fear and few were happy.

Eventually, the grasshoppers were able to force most everyone else to live by their rules. The ants, however, cared little about the politics of grasshoppers and continued to build their community as they had always done. In time, they developed an effective and highly distributed community with separate but similarly run hills all over the area. It wasn't long before the ant community became large enough to attract the attention of the greedy grasshoppers who at first felt the ants were just odd and had little
future but now realized that they actually had it quite good. They became jealous, and decided the best course of action was to claim the ants had infringed on their patents and should either be paying protection money or forced to give up their way of life. A few of the ants were fooled by this tactic and fell under the spell of the grasshoppers. The rest just laughed at the grasshoppers and went about building and improving their community.

The grasshoppers were perplexed by this. They were not accustomed to having others laugh and turn their backs on them. They considered appealing to the moles, but it was clear the moles would not help and would likely take away their precious patents rather than try and figure anything out.

Finally, greed and frustration led the grasshoppers to conclude an all out attack on the ants was needed. Armed with their lawyers they took to the skies. Spotting what looked to be the center of the community they swarmed down upon the ants and issued writs and filed injunctions. Smug in their superiority, the grasshoppers left confident that they had won and would see or hear little from the ants ever again.

The ants, of course, were not defeated in the least. Other communities rallied around them and life went on much as before. The ants continued to expand and prosper. The other creatures saw this and one by one abandoned the grasshoppers and their restrictive licenses. From time to time the grasshoppers would issue venomless threats but the ever expanding ant community paid little attention.

After one particularly long and dark winter, the grasshoppers awoke to find themselves alone and irrelevant. A few of the braver ones crossed the stream and joined the ants. The rest stood around dazed, confused and unable to comprehend what had happened.
I was on ThinkGeek.com the other day looking for things to beg my mother for. I came up with a list of the most awesome (and geeky!) gifts that your parents’ credit card can order! Here it is...

/dev/blanket
http://www.thinkgeek.com/homeoffice/blankets/574a/

This blanket has a nice terminal-green on black pattern of 1’s and 0’s all over it.

The blanket is 85% acrylic and 15% polyester. Perfect for keeping you warm as you code your way through this holiday season. Price: $39.99 USD

GP2X
http://wiki.gp2x.org/wiki/Where_to_Buy

The world’s very first handheld open-source Linux-based gaming platform, now with a touchscreen! The nice thing about this is that it’s fully hackable. You can download games for it off the internet and even develop your own without a license. It also plays music and video, and a perfect Christmas present for anyone who likes Linux or Open Source. Price: ~$169.99 USD

Linux Format
http://www.linuxformat.co.uk/

It has great tutorials, reviews, interviews, and a LiveDVD every month full of software. At the time of writing, the main article of the magazine is “10 Great DIY Projects”, and the DVD features Xubuntu 7.04. It’s a great magazine for learning as well as staying in touch with the Linux community. Price: $178 USD (~124 euros or £90) for a one year subscription.

Ubuntu Merchandise
https://shop.canonical.com/

How could I possibly not include this in an article for an Ubuntu magazine? Show off your Ubuntu pride and promote Free/Open Source software with this excellent merchandise! You can get keychains, notebooks, T-shirts and even USB flash drives with the Ubuntu logo on them. They also sell CDs in case you need a large quantity for a business or an organization. Price: Varies, £7.50 UK for a basic T-shirt.
The Ubuntu-Women (UW) Project was founded by Vidya Ayer in January 2006 when Mark Shuttleworth granted official status to the project and by March we had a mailing list and also a new website: [www.ubuntu-women.org](http://www.ubuntu-women.org).

Currently UW comprises a team of volunteers to provide a platform of encouragement and direction for women to contribute to Ubuntu-Linux, a Debian based free and open-source GNU/Linux software. The Flosspols report, indicates that about 1.5% of FLOSS community members were female, compared with 28% in proprietary software, which is slightly higher at 2.4% women according to the Ubuntu Census Survey (June 2006). At present we have many active women volunteers like Susana, Elizabeth, Romana, Sheri, Isabelle, Dinda and many more, who span different timezones across the globe. Our main goal is to provide visibility to women who contribute and don different technical and non-technical roles in the Ubuntu community. Programming being highly development-oriented and a plethora of distro's makes it more difficult in terms of identifying a problem in "X" application, and knowing how to 'fix' it. With UW we have tried to create a platform for women to communicate openly and ask technical questions without any fear of being flamed or ridiculed for asking silly beginner questions.

**You and Ubuntu Women**

- If you are a FLOSS developer, we have a Mentoring program along the lines of Each-One-Teach-One, and would like to have volunteers willing to mentor women in specific technical tasks (such as writing patches, bug testing, writing specifications and maintaining packages thereby enabling support to learn and grow.

- Sponsor women who wish to give technical presentations about Ubuntu at International conferences and seminars.

- Organize Ubuntu hack-fests, bar camps for women at Linux conferences or local events.

You can use the mailing list ([https://lists.ubuntu.com/mailman/listinfo/ubuntu-women](https://lists.ubuntu.com/mailman/listinfo/ubuntu-women)) or channel #ubuntu-women on freenode.net to run courses on Ubuntu-related development or any technical topic.

UW membership has always been open to all, irrespective of gender and you could figure on our Profiles page by joining us and ushering in change and diversity via Ubuntu-Women!
This month I will be talking about CNR (Click and Run), a package manager from Linpire which will be implemented into Ubuntu in the near future. They have released their first beta for Ubuntu. The following is how Linpire describes CNR:

CNR.com is a free one-click software delivery service designed to standardize the process and eliminate the complexity of finding, installing and managing Linux software for the most popular desktop Linux distributions, both Debian and RPM based. Please note that CNR.com is currently in beta stage.

So essentially all you need to do is download the client, install it. A button appears in your Applications > System Tools menu that says CNR on it. Click on it and it’ll open Firefox and point it to www.cnr.com, then search for your desired software. Then you download the software, and the CNR client installs it. There is talk going around about it (CNR) being put into Ubuntu. To sum it up: there is a combination of open source software and proprietary software, a combination of the ideas of Synaptic/Apt and the deadly Automatix.

All open source and free proprietary software (such as Adobe Reader etc) remain free. Subscription to the CNR Premium Service gives you discounts on non-free software and other privileges. You can find more information about it at http://url.fullcirclemagazine.org/8f735b. There is also a basic free membership that CNR offers, but you don't need a membership to install free software from CNR.

Now that I've explained what CNR is, the next thing is how to set the thing up. There are instructions at http://url.fullcirclemagazine.org/292ff4; but be warned, the software is still in the beta stages of life. For the article, I have tested the CNR software on my Ubuntu Gutsy Gibbon Computer. When I opened the 7MB deb file, I had 5 dependencies that needed to be installed prior to installing CNR. Once it's done, select CNR from the Applications > System Tools menu. A green orb with a picture of a man will appear in your status bar. To access the cnr.com site, you just click on the green button.

As a demonstration, I attempted to install Adobe Reader. You click on the install button and Firefox prompted me to download a .cnr file. I did, but
I had no idea how to install it. This is what CNR says is supposed to happen:

Just click the green running man icon next to any software.

Once you find a program, you can install it by clicking the green running man icon next to the program listing or on the product page for that program.

1) Click the green running man to install an individual program.

With that single click the program will download and install on your computer. You'll know the program is installing when the green running man at the bottom right of the CNR window begins to spin. A progress bar will also appear in the bottom of your window.

2) The green running man will spin as the program installs.

Once the installation is complete a shortcut to the program will appear on your desktop. The installed program will also be saved under the History tab in the CNR Client.

Advanced users can also download CNR software via the command line.

And then I find out that it only supports Feisty Fawn. Go figure. So I try Opera, and the same thing occurs. Now, there is a picture of it actually working here, showing what it should do when you click on the Install button. Then I realise that I forgot to log out and in of Ubuntu. So I do that and try it again, and Opera installs. The concept is interesting, although I would much rather not require to search for software using a web page, rather the search capabilities be accessed using the client.

The client is used for managing the apps that you install through CNR. It runs in the background and it installs the software when you click on the install button. It also allows you to choose one of six themes for the client (how interesting), choose the server that you want to download from, and allows you to uninstall programs.

The concept of CNR is interesting, but I do predict that there will be a large backlash amongst some of the Ubuntu community, and that is expected. Has Ubuntu done the deal with the devil? Have they made the right choice in bundling CNR with Ubuntu? Those questions will be answered in the course of next year.

I give CNR four out of five, although I'm not convinced that Opera is better than Firefox...
First I want to thank you for an excellent online magazine. I have been following it since the start. You are doing an excellent job!

I have been an Ubuntu user since the release of 7.04 and I have to admit, I finally found a distribution that I am happy with. I have it installed on 3 of our 4 home PCs. My wife and children took to it like it had always been there. In addition, I have installed the Ubuntu server product and a few workstations at work to save on licensing and other things. (Four separate hospitals) The experience has been awesome!

As the magazine grows toward maturity, I would like to see a little side column be developed for the intermediate crowd. Something like, how it works. Maybe titles could be: How Ubuntu boots up, The file system (its layout and function), So what

is this init thing anyway? ... things like that. It seems that the magazine is geared toward new users to push their knowledge envelope and that is wonderful, but putting some intermediate stuff in there will push the knowledge base of the intermediate users.

Joe Hildreth

As a confirmed Ubuntu user from Dapper days, I am amazed that any articles published on upgrading always seem to expect that I will download the new version over the internet. As I usually get the later versions on CD or DVD I would like to be able to use that medium to do my upgrade. I have Gutsy on CD and I did use: sudo apt-cdrom add to add the CD to my sources file.

When I tried to upgrade, I was connected to the internet and ubuntu decided to download all 1,050 or more upgrade files.

Several hours later it then tried to apply the downloaded upgrades and kept giving me messages about the need to either keep or ignore various
packages to which I replied.

After several more hours, the upgrade went into limbo and I left it for a few more hours in the hope that it would somehow wake up and complete.

I eventually turned the machine off and was somewhat surprised to actually see version 7.10 kick into life when I next turned it on.

What I would like to see is an article targeted towards users who want to upgrade from the CD or DVD. It seems that a different method needs to be used with each release. Is this correct?

Also, you might like to look at 2 programs I found recently. They are: deborphan which shows installed programs which have no dependencies and debfoster which displays a list of installed programs with the option of removing them.

Brian Dixon

Ed: Thanks for the tip with the two deb apps, I'll definitely look in to them. And I agree with you about

the upgrade procedure. I tried upgrading over the internet from Feisty to Gutsy and it failed, after taking hours to download all the files, probably most of the files being things it didn't need! Anyway, I'm sure the Ubuntu team are taking note of all these little niggles.

First of all, I love your magazine but looking at issue 4, page 2, in the copyright notice text it says: "and the url www.fullcirclemagazine.org". This is not a URL, it is a host name, which is only a part of a URL. Another part, for instance, is the protocol name. See: http://www.faqs.org/rfcs/rfc1738.html for details.

Greg Reagle

Ed: Ok, now you're just being picky!

It is a little misleading to entitle the article using the 7.10 distribution of Ubuntu. Wubi/Ubuntu 7.10 is not quite ready for prime time. You wouldn't even guess this from the article until perhaps the end where the alpha releases of Wubi are mentioned. My experience and others have been disappointing so far with the new release of Wubi/Ubuntu. I loved using it with the earlier release and am looking forward to a stable version soon.

Harvey B. Herman

Ed: Check out our step-by-step install of Wubi this month.

I have just read your Q&A section 7th issue of Full Circle Magazine and I have spotted an error: in the question about using 4 GB of RAM the answer was that you have to use the 64-bit version of Ubuntu. This is plainly wrong - it is enough to install kernel with PAE support (i.e. linux-image-VERSION-server package) and boot it.

Krzysztof Lichota

Ed: Thank you for the clarification on that one. Robert Clipsham has been suitably slapped and had his IRC clients taken off him until further notice.
Q What is this Christmas thing anyway?

A According to the wonderful source of information, Uncyclopedia.org, "Christmas is a public holiday celebrating discounts at Wal Mart". I decided I would investigate this more, and found out that Wal Mart recently unveiled a $200 PC running Ubuntu with the Enlightenment desktop. Hurrah for Christmas!

http://uncyclopedia.org/wiki/Christmas

Q Are there any Christmassy Ubuntu games?

A How about SnowballZ? It's a simple penguin-based game involving the throwing snowballs and penguins. What more could you ask for? The Top5 is a set of Ubuntu games, maybe we could just use it here instead of down below?

http://packages.ubuntu.com/snowballz

Q And who's the guy with the big belly?

A You must be talking about Santa. Santa recently became unemployed in favor of the more popular and adorable Santa-Tux. Don't worry, you'll still get your presents!

Q I've made my desktop all Christmassy, and want to see what other people have done to theirs for Christmas - where can I go?

A Try the below thread on the Ubuntu Forums. Feel free to post your there, and borrow some ideas! Also, check out Andrew Min's guide to gearing up your desktop for the holidays on page 11.

http://ubuntuforums.org/showthread.php?t=628244

Q Where would I find a top 5 list of Christmas Ubuntu apps?

A Try the Full Circle Top 5 on page 37.
My computer is 3 years old. It's a decent computer. It has a Pentium 4 3GHz Processor, 512MB RAM, 1x160GB Hard Drive with XP Pro and Ubuntu Gutsy dual boot (Gutsy has 80GB and XP has 70GB) with a DVD Burner, an nVidia 7600 GS graphics card and a wireless keyboard and mouse which eats through far too many batteries. And a BenQ FP731 17" LCD monitor. My wallpaper is a picture of a holiday that I went to in the Australian summer to a town called Inverloch, in Gippsland, Victoria. The bottom panel is almost transparent, whereas the top panel is less transparent. I haven't done anything spectacular to it, just added icons to the top panel as needed. I love Gutsy and will continue to run it even when I make the switch to a Mac soon.

My desktop screenshot, running a conky script, on Gnome with Fusions GTK2 Theme. The wallpaper is a graphic I found on Gnome-Look.org. I inverted the colors with The GIMP.

Currently, I run an AMD 64 Athlon 3400+ with 512 MB of RAM and a 160 GB Hard Drive.
Frozen Bubble

Homepage: http://www.frozen-bubble.org/

On the surface, Frozen Bubble looks like a rather simple game. The object is to shoot little balls at other little balls of the same color. Simple, right? That's what I thought, but what started out as research for this article turned into a ball shooting frenzy that lasted for longer than I'd care to say. It is sufficient to state that this game is hours of fun. Disclaimer: If you are fired for playing Frozen Bubble during that important meeting, I am not to blame.

To install Frozen Bubble, grab the frozen-bubble package in the universe repository. You can also run an online Java applet at: http://url.fullcirclemagazine.org/df9687

Extreme Tux Racer

Homepage: http://www.extremetuxracer.com/

Extreme Tux Racer is another extremely hard and extremely addicting game. Like Frozen Bubble, the premise seems absurdly easy: race down a hill collecting herring. However, you need to get every single herring to win. Oh, one more thing: you can't go backwards! And don't forget about the slippery ice, the trees, the jumps, or the time limit.

Extreme Tux Racer hasn't yet made it into the repositories. Luckily, you can download a .deb created by a user named Hamish. You can also install an older version known as Planet Penguin Racer using the package planetpenguin-racer in the universe repository.
Super Tux

Homepage: http://supertux.lethargik.org/

Everyone's played the classic platform game Super Mario. Even if it is closed-source, commercial, and Nintendo-licensed platforms-only, it's a ton of fun. But some of us don't own Nintendo machines. In this awesome game Tux replaces the plumber, the almost-as-lovable penguin, Penny, replaces Princess Peach, and the enemies are replaced by walking snow balls, ice blocks, cherry bombs, and flying snow balls.

To get Super Tux, just download and install the supertux package in the universe repository.

Snowballz

Homepage: http://www.joey101.net/snowballz/

If you're tired of playing mindless arcade games, try Snowballz. It's a unique real-time strategy game involving... penguins and snowballs. In the game you control two types of penguins: workers and snowballers. Your workers gather fish to feed your colony and your snowballers invade other penguins' igloos. But when you invade other penguins' igloos, enemy snowballers come out and fight back. Snowballz also includes a fun LAN mode, so you can pelt your boss friends with snowballs. To start playing this great game, install the snowball package in the universe repositories.

Xsnow

Homepage: http://www.euronet.nl/~rja/Xsnow

Xsnow will send showers of snow down your desktop, landing gracefully on your windows or taskbar. You'll also notice that the snow will cover your icons (you can "wipe" them with your cursor and they'll come right back). And if you're lucky, you might spot Santa flying by.

To get Xsnow, download the xsnow package from the multiverse repository. If you use Kubuntu, make sure you enable "Support Programs in Desktop Window" in System Settings > Desktop > Behavior (Ubuntu will work out of the box).
How to Contribute

We are always looking for new articles to include in Full Circle. For article guidelines, ideas, and for issue translation, please see our wiki: http://wiki.ubuntu.com/UbuntuMagazine

Please email your articles to: articles@fullcirclemagazine.org

If you would like to submit news, email it to: news@fullcirclemagazine.org

Send your comments or Linux experiences to: letters@fullcirclemagazine.org

Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org

Questions for future interviews should go to: questions@fullcirclemagazine.org

Lists and desktop/PC photos should be emailed to: misc@fullcirclemagazine.org

If you have questions, you can visit our forum: www.fullcirclemagazine.org

Deadline for Issue #9:

Release date for issue #9:
Friday 25th January 2008.

Have Your Say

If you want to have your say in how Full Circle develops, please attend our monthly IRC meeting.

You can find our next agenda at: http://url.fullcirclemagazine.org/f2ba08

We want the input of you, the reader, to help us make decisions that affect the magazine.

Next general, all welcome, meeting: Sat. 12th January 2008

Meetings take place in the IRC channel #fullcirclemagazine, which is on the irc.freenode.net server. Or you can use our webIRC page which is at http://irc.fullcirclemagazine.org and it will allow you to interact with our IRC channel from within your web browser.

Full Circle Team

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org

Webmaster - Rob Kerfia
admin@fullcirclemagazine.org

Comms Mgr - Robert Clipsham
mrmunday@fullcirclemagazine.org

Podcast - Matthew Rossi
podcast@fullcirclemagazine.org

Contributors
Samuel Barrett
Robert Clipsham
Daniel Cohen
Philipp Höhn
Andrew Min
Vid Ayer

Proof Readers
Nicola Cappellini
Ryan Hartlage
David Maino
Andrew Min
James Savage
Jonny Dover
Matthew Holder
Richard Mills
Alex Russell
James Williams

And our thanks go out to Canonical, the Ubuntu Marketing Team and the many translation teams around the world.